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Using the Library Guide and Common Index 

The IBM® TotalStorage™ FAStT Storage Manager Version 8.4 Library Guide and 

Common Index applies to the IBM TotalStorage Storage Manager Version 8.4 

software library. Storage Manager Version 8.4 supports Linux, Novell NetWare, 

Microsoft® Windows NT®, Windows® 2000, Windows Server 2003, VMware, HP-UX, 

AIX, and Solaris operating systems. 

Use this softcopy document as a dynamic task-oriented guide to the FAStT library 

and cross index of related topics. Dynamic links from the master index to particular 

chapters, headings, and sections within these documents operate only when those 

documents reside together in the same directory as the FAStT Library Guide and 

Common Index. Links to Internet documents cited outside the index depend on the 

proper configuration of your Adobe Acrobat Reader. 

If your Adobe Acrobat Reader is not configured to access the Internet and to take 

full advantage of the FAStT Library Guide and Common Index, identify the version 

of your Acrobat Reader and configure it as follows: 

Acrobat Reader 4.0  

1.   Click File -> Preferences -> General. 

2.   Clear the Web browser integration box. 

3.   Click OK. 

4.   Click File -> Preferences -> Weblink... 

5.   Set the Web browser application to use an external browser (for example, 

Navigator or Internet Explorer). 

6.   Click OK. 

7.   Click File -> Preferences -> Web capture... 

8.   Change the Open Weblinks field to In Web Browser.

Acrobat  Reader 5.0  

1.   Click Edit -> Preferences -> Web capture 

2.   Change the Open Weblinks field to In Web Browser.

Click this button for information about Adobe Acrobat Reader, as well as to get 

downloads of the reader: 

Adobe Acrobat Downloads 
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Contents of this document 

This document consists of the following sections: 

v   “FAStT installation process overview” on page 5 

 An installation overview diagram that associates the hardware and software 

documents with their ordered installation tasks. 

v   “FAStT documentation” on page 7 

 Tables that detail FAStT product libraries whose document titles are associated 

with common user tasks and link you to complete texts on the Internet. 

v   “Master Index: FAStT Storage Manager 8.4” on page 9 

 Index entries that link you directly to their respective references within each of 

the following documents as updated for the current release: 

1.   IBM TotalStorage FAStT Storage Manager 8.4 Installation and Support Guide 

for Intel-based Operating System Environments, GC26-7589 (coded in the 

index as INTEL) 

2.   IBM TotalStorage FAStT Storage Manager Version 8.4 Installation and 

Support Guide for AIX®, UNIX, and Solaris, GC26-7574 (coded in the index 

as UNIX) 

3.   IBM TotalStorage FAStT Storage Manger Concepts Guide, GC26-7560 

(coded in the index as CONCEPTS) 

4.   IBM TotalStorage FAStT Storage Manager Copy Services User’s Guide, 

GC26-7561 (coded in the index as COPYSERV)

This document is intended to be used in softcopy form. Independent use of this 

document in hardcopy form is, therefore, significantly limited.
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FAStT  installation process overview 

Figure 1 gives an overview of the FAStT hardware and the FAStT Storage Manager 

software installation process. Lined arrows in the flow chart indicate consecutive 

steps in the hardware and software installation process. Labeled arrows indicate 

which current documents provide detailed information about those steps. 
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Figure 1. Installation process flow by current publications
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FAStT  documentation 

The following table presents an overview of the FAStT Storage Manager product 

library. The table lists documents included in the library and what common tasks 

they address. Click on active links in the tables to access those documents 

currently available on the Internet. You can access documentation for the other 

FAStT products at the following Web site: 

ssddom02.storage.ibm.com/techsup/webnav.nsf/support/fastt/ 
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FAStT Storage Manager Version  8.4 library 

Table 1 associates each document in the FAStT Storage Manager library with its 

related common user tasks. 

 Table  1. TotalStorage FAStT Storage Manager Version 8.4 titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

FAStT Storage 

Manager 8.4 Library 

Guide and Common 

Index, GC26-7600 

U U U U  U U 

IBM TotalStorage 

FAStT Storage 

Manager 8.4 

Installation and 

Support Guide for 

Intel-based 

Operating System 

Environments, 

GC26-7589 

U U U  

IBM TotalStorage 

FAStT Storage 

Manager 8.4 

Installation and 

Support Guide for 

AIX, UNIX, and 

Solaris, GC26-7593 

U U U  

IBM TotalStorage 

FAStT Storage 

Manager Copy 

Services User’s 

Guide, GC26-7561 

U U U  U 

IBM FAStT Storage 

Manager Script 

Commands (see 

product CD) 

U  

IBM TotalStorage 

FAStT Storage 

Manager Concepts 

Guide, GC26-7560 

U U U U  U U 
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Special characters
  CONCEPTS–12 

A
about this document CONCEPTS–xi, COPYSERV–xi, 

INTEL–xiii, SM84UNIX–xi 

access logical drive INTEL–9 

access LUN SM84UNIX–52, SM84UNIX–69 

Access LUN mapping
changing INTEL–125 

defining INTEL–125 

access volume CONCEPTS–16, SM84UNIX–1 

access volume, detecting after host restart INTEL–115, 

INTEL–118 

access volumes SM84UNIX–8 

activating the Remote Mirror Option COPYSERV–114, 

COPYSERV–116 

add device option CONCEPTS–21 

adding logical drives INTEL–117 

adding
devices INTEL–103 

logical drives INTEL–109 

address, IBM CONCEPTS–xvi, COPYSERV–xvii, 

INTEL–xx 

address
for e-mail comments SM84UNIX–xv 

for reader comment form SM84UNIX–xv 

of IBM SM84UNIX–xv 

of the IBM director of licensing SM84UNIX–119 

administrator privilege requirements INTEL–25, 

INTEL–91 

ADT feature CONCEPTS–40, CONCEPTS–43 

Advanced menu CONCEPTS–26 

agent software
package SM84UNIX–5 

AIX and Sun Solaris, failover protection CONCEPTS–43 

AIX
client software SM84UNIX–19 

configuration of storage subsystems SM84UNIX–20, 

SM84UNIX–25 

configure the host COPYSERV–25 

direct-attached configuration SM84UNIX–23 

firmware
requirements SM84UNIX–17 

upgrading SM84UNIX–21 

FlashCopy
creating a FlashCopy logical drive 

COPYSERV–25 

hardware requirements SM84UNIX–101 

identifying
controller ID numbers SM84UNIX–33 

device names and bus numbers SM84UNIX–34 

FlashCopy volume types SM84UNIX–39 

logical drives by operating system device names 

SM84UNIX–37 

NVSRAM
requirements SM84UNIX–17 

AIX (continued)
NVSRAM (continued)

upgrading SM84UNIX–22 

operating system requirements SM84UNIX–13, 

SM84UNIX–14, SM84UNIX–17 

RDAC driver
configuring SM84UNIX–26 

installing SM84UNIX–24, SM84UNIX–25, 

SM84UNIX–26 

requirements SM84UNIX–25, SM84UNIX–101 

verifying SM84UNIX–25 

requirements
client software SM84UNIX–19 

firmware SM84UNIX–17 

hardware SM84UNIX–17, SM84UNIX–101 

operating system SM84UNIX–13, SM84UNIX–14 

RDAC driver SM84UNIX–24, SM84UNIX–25, 

SM84UNIX–101 

software SM84UNIX–101 

system SM84UNIX–101 

restrictions COPYSERV–9, COPYSERV–15, 

COPYSERV–38, SM84UNIX–7, SM84UNIX–8, 

SM84UNIX–18 

reusing a FlashCopy logical drive COPYSERV–31 

SAN-attached configuration SM84UNIX–24 

SMclient SM84UNIX–20 

SMruntime SM84UNIX–20 

software requirements SM84UNIX–101 

system requirements SM84UNIX–101 

volumes, redistributing in case of failure 

SM84UNIX–45 

alert destinations CONCEPTS–73 

alert destinations
configuration CONCEPTS–81 

configuring CONCEPTS–81 

setting CONCEPTS–80 

alert notification
configuring alert destinations CONCEPTS–81 

mail server configuration CONCEPTS–80 

overview CONCEPTS–80 

selecting the node CONCEPTS–80 

setting CONCEPTS–82 

setting alert destinations CONCEPTS–80 

alert notifications, configuring SM84UNIX–97 

alert notifications, setting up INTEL–103 

Allocate Capacity panel COPYSERV–13, 

COPYSERV–14 

array CONCEPTS–7 

arrays, creating INTEL–105 

assigning
IP addresses INTEL–32 

static drive letters INTEL–54 

associated logical drives, locating COPYSERV–61 

attributes
dac SM84UNIX–28, SM84UNIX–31 

dar SM84UNIX–26, SM84UNIX–30 

definitions SM84UNIX–26 

hdisk SM84UNIX–29, SM84UNIX–31, SM84UNIX–32 
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attributes (continued)
LUN SM84UNIX–29, SM84UNIX–31, SM84UNIX–32 

RDAC driver SM84UNIX–26 

audience CONCEPTS–xi, COPYSERV–2, INTEL–xiii 

audience of this document SM84UNIX–xi 

auto LUN/Array transfer INTEL–123 

Auto Volume Transfer (AVT) SM84UNIX–61, 

SM84UNIX–93 

Auto-Logical Drive Transfer (ADT) feature 

CONCEPTS–40 

automatic discovery option CONCEPTS–21 

automatic host discovery INTEL–101 

automatic storage subsystem discovery INTEL–100, 

INTEL–101 

B
background media scan CONCEPTS–45 

BOOTP server
BOOTP table INTEL–44 

sample network INTEL–11 

setting up INTEL–38 

UNIX INTEL–44 

BOOTP-compatible server, setting up INTEL–33 

bus numbers and device names, identifying 

SM84UNIX–34 

C
cabling examples

Campus configuration COPYSERV–106 

Highest Availability Campus configuration 

COPYSERV–101 

Intra-site configuration COPYSERV–111 

Remote Mirror Option
Campus configuration COPYSERV–106 

cabling instructions CONCEPTS–xi, COPYSERV–xi, 

INTEL–xiii, SM84UNIX–xi 

cache flush
described CONCEPTS–44 

performance impacts CONCEPTS–44 

settings CONCEPTS–44 

start percentage CONCEPTS–44 

stop flush percentage CONCEPTS–44 

cache hit percentage CONCEPTS–91 

cache hit
optimizing CONCEPTS–91 

percentage CONCEPTS–91 

cache mirroring SM84UNIX–32, SM84UNIX–45 

cache read-ahead, choosing a multiplier 

CONCEPTS–90 

Campus configuration CONCEPTS–57 

Campus configuration
cabling examples COPYSERV–106 

overview COPYSERV–105 

setting up COPYSERV–107 

switch zoning COPYSERV–105 

capacity
Dynamic Capacity Expansion (DCE) CONCEPTS–39 

free CONCEPTS–7 

unconfigured CONCEPTS–7 

capture state information feature INTEL–105, 

SM84UNIX–98 

catastrophic failure SM84UNIX–98 

channel protection, using CONCEPTS–63 

checklists for the Remote Mirror Option, hardware and 

software COPYSERV–117 

client software
AIX SM84UNIX–19, SM84UNIX–20 

HP-UX SM84UNIX–48, SM84UNIX–49 

HP-UX
installing SM84UNIX–48 

package SM84UNIX–4, SM84UNIX–6 

Solaris SM84UNIX–65, SM84UNIX–66 

cluster configuration
for Windows 2000

creating logical drives INTEL–112 

deleting logical drives INTEL–112 

for Windows NT
creating logical drives INTEL–110 

deleting logical drives INTEL–110 

for Windows Server 2003
creating logical drives INTEL–113 

deleting logical drives INTEL–113 

upgrading from Windows NT 4.0 to Windows 2000 

INTEL–80 

upgrading to Windows Server 2003 INTEL–82 

cluster server
environment

hardware configuration options INTEL–61 

host adapters INTEL–62 

installing hardware INTEL–61 

installing Storage Manager INTEL–63 

installing Windows software INTEL–61 

storage subsystems INTEL–63 

software
installing INTEL–74 

verifying installation INTEL–74 

cluster services
configurations SM84UNIX–95 

hardware requirements SM84UNIX–99 

HP-UX requirements SM84UNIX–99 

MC/Service Guard SM84UNIX–99 

Solaris requirements SM84UNIX–99, 

SM84UNIX–100 

system dependencies SM84UNIX–99 

VERITAS Cluster Server SM84UNIX–99 

VERITAS Volume Manager SM84UNIX–99 

coexisting storage subsystems, managing 

CONCEPTS–18, INTEL–18 

command line interface (SMcli)
examples CONCEPTS–34 

overview CONCEPTS–29 

parameters CONCEPTS–30 

usage and formatting requirements CONCEPTS–33 

using CONCEPTS–29 

commands
fget_config SM84UNIX–36 

lsattr SM84UNIX–37 

lsdev SM84UNIX–35 

comments about this document, how to send 

SM84UNIX–xv 
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comments, how to send CONCEPTS–xvi, 

COPYSERV–xvii, INTEL–xx 

complete SM SW installation CONCEPTS–xi, 

COPYSERV–xi, INTEL–xiii, SM84UNIX–xi 

component failures COPYSERV–142 

components button CONCEPTS–87 

components, storage subsystem CONCEPTS–6 

components
software CONCEPTS–8 

Concepts Guide CONCEPTS–xi, CONCEPTS–xiii, 

COPYSERV–xi, COPYSERV–xiii, INTEL–xiii, 

INTEL–xv, SM84UNIX–xi, SM84UNIX–xiii 

configuration details, MC Service Guard 

SM84UNIX–107 

configuration options, installing hardware in a cluster 

server environment INTEL–61 

configuration recovery INTEL–105, SM84UNIX–98 

configuration types
cluster server configuration INTEL–15 

installing storage manager 7.02 INTEL–13 

standard (noncluster) configuration INTEL–14 

configuration, storage subsystem CONCEPTS–59 

configuration
Highest Availability Campus

overview COPYSERV–98 

mail server CONCEPTS–80 

sender address CONCEPTS–80 

software
verifying COPYSERV–118 

configurations
Campus CONCEPTS–57 

Campus
cabling examples COPYSERV–106 

overview COPYSERV–105 

setting up COPYSERV–107 

switch zoning COPYSERV–105 

Highest Availability Campus CONCEPTS–57 

Highest Availability Campus
cabling examples COPYSERV–101 

setting up COPYSERV–102 

switch zoning COPYSERV–99 

inappropriate COPYSERV–141 

Intra-site CONCEPTS–57 

Intra-site
cabling examples COPYSERV–111 

overview COPYSERV–109 

setting up COPYSERV–111 

switch zoning COPYSERV–110 

supported CONCEPTS–57 

configure storage hardware CONCEPTS–xi, 

COPYSERV–xi, INTEL–xiii, SM84UNIX–xi 

configure storage subsystems on host CONCEPTS–xi, 

COPYSERV–xi, INTEL–xiii, SM84UNIX–xi 

configuring heterogeneous hosts INTEL–106 

configuring
alert notifications SM84UNIX–97 

direct-attached SM84UNIX–23, SM84UNIX–55, 

SM84UNIX–70 

RDAC driver SM84UNIX–26, SM84UNIX–100 

SAN-attached SM84UNIX–24, SM84UNIX–55, 

SM84UNIX–71 

configuring (continued)
Solaris with JNI host bus adapter cards 

SM84UNIX–71, SM84UNIX–72 

storage subsystems
AIX SM84UNIX–20, SM84UNIX–23, 

SM84UNIX–24 

HP-UX SM84UNIX–52, SM84UNIX–55 

procedures SM84UNIX–95 

Solaris SM84UNIX–69, SM84UNIX–70, 

SM84UNIX–71 

connect power CONCEPTS–xi, COPYSERV–xi, 

INTEL–xiii, SM84UNIX–xi 

connection distance CONCEPTS–56, COPYSERV–90 

connectivity and I/O CONCEPTS–55, COPYSERV–88 

connectivity
connection distance COPYSERV–90 

logical drive ownership COPYSERV–88 

performance considerations COPYSERV–90 

considerations of performance COPYSERV–90 

Contacting Device status CONCEPTS–74 

controller CONCEPTS–6 

controller cache memory
data protection CONCEPTS–44 

controller enclosure CONCEPTS–6, CONCEPTS–44 

Controller menu CONCEPTS–25 

controller ownership of logical drives CONCEPTS–55 

controller state capture SM84UNIX–98 

controller transfer rate, optimizing CONCEPTS–90 

controller
information record INTEL–133 

state capture INTEL–105 

controllers
firmware SM84UNIX–1, SM84UNIX–25, 

SM84UNIX–52, SM84UNIX–69 

ID numbers, identifying SM84UNIX–33 

IP addresses SM84UNIX–14 

copy failed status COPYSERV–65 

copy in progress status COPYSERV–64 

copy pairs, removing COPYSERV–70 

copy pending status COPYSERV–64 

copy priorities, changing COPYSERV–66 

copy priority
setting COPYSERV–54 

Copy Services Guide CONCEPTS–xiii, COPYSERV–xiii, 

INTEL–xv, SM84UNIX–xiii 

copy services
FlashCopy CONCEPTS–48 

Remote Mirror Option CONCEPTS–48 

VolumeCopy CONCEPTS–48 

copy status, VolumeCopy COPYSERV–64 

copy status
copy failed COPYSERV–65 

copy in progress COPYSERV–64 

copy pending COPYSERV–64 

copyback CONCEPTS–45 

Create Copy wizard
using COPYSERV–48 

Create Copy Wizard
Introduction panel COPYSERV–50 

selecting the source logical drive COPYSERV–50 

selecting the target logical drive COPYSERV–51 
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Create Copy Wizard (continued)
setting the copy priority COPYSERV–54 

the Preview panel COPYSERV–55 

viewing drives COPYSERV–56 

Create Remote Mirror wizard
use to create mirror relationships COPYSERV–121 

creating logical drives, step-by-step CONCEPTS–59 

creating
arrays and logical drives INTEL–105 

logical drives INTEL–109, INTEL–111, INTEL–117 

storage partitions CONCEPTS–67 

critical event notification CONCEPTS–81 

critical event notification
through SNMP CONCEPTS–80 

critical event problem solving CONCEPTS–93 

critical event scenarios COPYSERV–144 

critical events table COPYSERV–144 

critical events, troubleshooting COPYSERV–143 

critical events, VolumeCopy COPYSERV–78 

customer support alert notification
how to configure CONCEPTS–80 

D
dac attributes SM84UNIX–28, SM84UNIX–31 

damaged site, rebuilding COPYSERV–130 

dar attributes SM84UNIX–26, SM84UNIX–30 

data path failover protection CONCEPTS–40 

data protection CONCEPTS–109 

data protection strategies CONCEPTS–37 

data redundancy CONCEPTS–40 

data replication CONCEPTS–54, COPYSERV–85 

data sheet INTEL–133 

data
backing up CONCEPTS–50 

copying for greater access CONCEPTS–49 

restoring FlashCopy logical drive data 

CONCEPTS–50 

DCE (dynamic capacity expansion) SM84UNIX–42 

DCE (Dynamic Capacity Expansion) CONCEPTS–39 

default host group, defined CONCEPTS–64, 

CONCEPTS–68 

default host type, verifying and defining INTEL–106 

default logical drive-to-LUN mapping
defined CONCEPTS–65 

default LUN CONCEPTS–64 

default settings for failover protection CONCEPTS–43 

defining default host type INTEL–106 

delayed_fail SM84UNIX–40 

deleting logical drives INTEL–109, INTEL–111, 

INTEL–117 

determine management method CONCEPTS–xi, 

COPYSERV–xi, INTEL–xiii, SM84UNIX–xi 

Device Table CONCEPTS–73 

Device Tree CONCEPTS–73 

devices
identification SM84UNIX–33 

names and bus numbers, identifying SM84UNIX–34 

DHCP server
creating a scope INTEL–40 

installing the DHCP Manager INTEL–40 

DHCP server (continued)
sample network INTEL–11 

setting up INTEL–33, INTEL–38 

DHCP/BOOTP server CONCEPTS–14, CONCEPTS–17 

direct (out-of-band) management method SM84UNIX–8 

direct (out-of-band) management method
advantages CONCEPTS–14 

described CONCEPTS–14 

disadvantages CONCEPTS–14 

direct-attached configuration SM84UNIX–23, 

SM84UNIX–55, SM84UNIX–70 

direct-management method workaround INTEL–124 

direct-management storage subsystems INTEL–9 

directly managed storage subsystems CONCEPTS–14 

disaster preparation checklist COPYSERV–128 

disaster recovery
backing up critical data COPYSERV–127 

defining storage partitioning COPYSERV–127 

disaster preparation checklist COPYSERV–128 

entire site failover procedure COPYSERV–129 

failover protection using the host clustering software 

COPYSERV–128 

overview COPYSERV–127 

planning for COPYSERV–127 

preparing the secondary storage subsystem 

COPYSERV–127 

rebuild a damaged site procedure COPYSERV–130 

recovering from storage subsystem failures 

COPYSERV–129 

recovering from switch failures COPYSERV–128 

recreate a mirror relationship procedure 

COPYSERV–130 

disk access, minimize CONCEPTS–92 

Disk Administrator utility
deleting LUNs INTEL–109, INTEL–111 

disk configuration INTEL–54, INTEL–68 

disk configuration information SM84UNIX–98 

disk space requirements INTEL–25, INTEL–91 

DMP SM84UNIX–6 

DNS table setup INTEL–49 

document organization CONCEPTS–xiii, 

COPYSERV–xiii, INTEL–xvi 

documentation
documents SM84UNIX–1 

FAStT CONCEPTS–xii, CONCEPTS–113, 

COPYSERV–xii, COPYSERV–147, INTEL–xiv, 

INTEL–135, SM84UNIX–xii, SM84UNIX–113 

FAStT Storage Manager Version 8.4 

CONCEPTS–xiii, COPYSERV–xiii, INTEL–xv, 

SM84UNIX–xiii 

files SM84UNIX–1 

online help SM84UNIX–xiii, SM84UNIX–2, 

SM84UNIX–96, SM84UNIX–98 

related CONCEPTS–117, COPYSERV–153, 

INTEL–139, SM84UNIX–117 

using CONCEPTS–xv, COPYSERV–xv, INTEL–xviii 

Web sites INTEL–xviii, SM84UNIX–xiv 

downloading firmware and NVSRAM INTEL–104 

drive CONCEPTS–6 

drive expansion enclosure CONCEPTS–6 

drive firmware, downloading CONCEPTS–76 
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Drive menu CONCEPTS–26 

drive, logical CONCEPTS–7 

driver INTEL–91 

drives, logical CONCEPTS–37 

drives, viewing COPYSERV–56 

DVE (Dynamic Logical Drive Expansion) 

CONCEPTS–39 

DVE (dynamic volume expansion) SM84UNIX–42 

dynamic capacity expansion (DCE) SM84UNIX–42 

Dynamic Capacity Expansion (DCE) CONCEPTS–39 

Dynamic Logical Drive Expansion (DVE) 

CONCEPTS–39 

dynamic multipathing SM84UNIX–6 

dynamic tracking SM84UNIX–41 

dynamic volume expansion (DVE) SM84UNIX–42 

E
e-mail address SM84UNIX–xv, SM84UNIX–97 

edition notice SM84UNIX–ii 

elements, storage topology CONCEPTS–67 

emwdata.bin file CONCEPTS–20 

enabling multipath I/O with PV-links SM84UNIX–56 

enabling the Remote Mirror Option COPYSERV–114, 

COPYSERV–116 

Enterprise Management window CONCEPTS–20 

Enterprise Management window
adding devices INTEL–103 

alert notifications INTEL–103 

component of SMclient CONCEPTS–8, INTEL–6 

description SM84UNIX–5 

Device Table CONCEPTS–73 

Device Tree CONCEPTS–73 

help CONCEPTS–1, INTEL–1 

maintaining storage subsystems CONCEPTS–73 

monitoring storage subsystems CONCEPTS–73 

Needs Attention icon CONCEPTS–74 

online help SM84UNIX–2 

overall health status pane CONCEPTS–73 

status icons displayed in CONCEPTS–73 

synchronizing CONCEPTS–83 

entire site failover procedure COPYSERV–129 

Environmental Services Monitor (ESM) card 

CONCEPTS–77 

errors, media scan CONCEPTS–46 

errors, secondary logical drive COPYSERV–86 

ESM
downloading card firmware CONCEPTS–77 

overview CONCEPTS–77 

estimated repository logical drive overhead
calculating COPYSERV–10 

sample calculation COPYSERV–10 

estimating logical drive capacity COPYSERV–9 

estimating logical drive capacity
considerations COPYSERV–10 

Ethernet MAC address, identifying INTEL–30 

event log CONCEPTS–93, CONCEPTS–109 

Event Monitor
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CONCEPTS–83 

disable INTEL–94 

example CONCEPTS–82 

Event Monitor (continued)
installing CONCEPTS–81 

overview CONCEPTS–81 
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CONCEPTS–83 

verifying installation INTEL–67 

event notification CONCEPTS–109 
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CONCEPTS–81 
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existing storage subsystem INTEL–15 
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operating system requirements INTEL–19 

system hardware requirements INTEL–19 

uninstall INTEL–92 

expansion units, updating the firmware CONCEPTS–75 

F
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fabric switches CONCEPTS–11, INTEL–20 

failover protection
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AIX and Sun Solaris CONCEPTS–43 

default settings CONCEPTS–43 

Linux CONCEPTS–43 

Microsoft Windows CONCEPTS–42 

Novell NetWare CONCEPTS–42 

operating system specific CONCEPTS–42 

overview CONCEPTS–40 

RDAC feature CONCEPTS–42 

using the host clustering software COPYSERV–128 

failure notification
example CONCEPTS–75 

in the Subsystem Management window 

CONCEPTS–75 

failure settings COPYSERV–36 

failure settings
repository capacity threshold warning level 

COPYSERV–8 

repository full policy COPYSERV–9 

failure support
cluster services SM84UNIX–99 

DMP driver SM84UNIX–6 

RDAC driver SM84UNIX–6 

redistributing volumes SM84UNIX–45, 

SM84UNIX–61, SM84UNIX–93 
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component COPYSERV–142 

fast I/O failure SM84UNIX–40 

fast_fail SM84UNIX–40 

FAStT documentation CONCEPTS–xii, 
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FAStT Management Suite Java (FAStT-MSJ) INTEL–1 

FAStT MSJ INTEL–1 
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installation procedure INTEL–95 
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FAStT MSJ (continued)
uninstall procedure INTEL–95 

FAStT SANavigator INTEL–1 

FAStT Storage Manager 8.4
user tasks CONCEPTS–xiii, COPYSERV–xiii, 

INTEL–xv, SM84UNIX–xiii 

FAStT Storage Manager Field Tool INTEL–105 

FAStT Storage Manager
related documents CONCEPTS–117, 

COPYSERV–153, INTEL–139, SM84UNIX–117 

Version 8.4 Library CONCEPTS–xiii, 

COPYSERV–xiii, INTEL–xv, SM84UNIX–xiii 

FAStT-MSJ CONCEPTS–11 
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FAStT200
restrictions CONCEPTS–48 
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COPYSERV–152, INTEL–138, SM84UNIX–116 
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FC storage server installation guide CONCEPTS–xi, 
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switches INTEL–21 
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access pattern CONCEPTS–90 

balancing the load CONCEPTS–89 

fibre-channel I/O (continued)
request rate optimizing CONCEPTS–90 

size CONCEPTS–90 
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files, defragmenting CONCEPTS–92 

filesets SM84UNIX–101 

firmware requirements CONCEPTS–13 

firmware
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upgrading SM84UNIX–21 

verifying SM84UNIX–25 

description SM84UNIX–1 
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downloading latest versions SM84UNIX–21, 
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HP-UX
requirements SM84UNIX–47 
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Solaris
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upgrading SM84UNIX–70 
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FlashCopy
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command line interface COPYSERV–25 

configure the host
AIX instructions COPYSERV–25 

HP-UX instructions COPYSERV–27 

Linux instructions COPYSERV–27 

Solaris instructions COPYSERV–29 

using the script editor and the command-line 

interface COPYSERV–25 
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COPYSERV–20 
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failure settings
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HP-UX
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FlashCopy (continued)
HP-UX (continued)

reusing a FlashCopy logical drive COPYSERV–32 

icon states COPYSERV–36 

Linux
reusing a FlashCopy logical drive COPYSERV–32 

logical drive CONCEPTS–37 

Logical Drive wizard
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resizing COPYSERV–42 
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modification operation COPYSERV–39 
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tasks COPYSERV–36 
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FlashCopy (continued)
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host computer CONCEPTS–3 
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HP-UX
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direct-attached configuration SM84UNIX–55 

firmware
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HP-UX (continued)
volumes, redistributing in case of failure 

SM84UNIX–61 

HyperTerminal version SM84UNIX–14 

I
I/O access pattern and I/O size CONCEPTS–90 

I/O data field CONCEPTS–89 

I/O data path protection CONCEPTS–40 

I/O request rate, impact from cache flush settings 

CONCEPTS–44 

I/O request rate, optimizing CONCEPTS–90 

I/O transfer rate, optimizing CONCEPTS–90 

IBM address CONCEPTS–xvi, COPYSERV–xvii, 

INTEL–xx 

IBM FAStT Host Adapter device driver
QL2x00 INTEL–89, INTEL–95 

IBM FAStT Management Suite Java INTEL–95 

IBM Storage Area Network (IBMSAN) driver 

CONCEPTS–10 

IBM
address SM84UNIX–xv 

director of licensing address SM84UNIX–119 

e-mail address SM84UNIX–xv, SM84UNIX–97 

icon states COPYSERV–36 

identifying
AIX

controller ID numbers SM84UNIX–33 

device names and bus numbers SM84UNIX–34 

logical drives by operating system device names 

SM84UNIX–37 

in-band (host-agent) management method 

SM84UNIX–7 

in-band management method INTEL–8 

information from the World Wide Web CONCEPTS–xv, 

COPYSERV–xv, INTEL–xviii 

information record, storage subsystem and controller 

INTEL–133 

information, getting CONCEPTS–xiv, COPYSERV–xiv 

install and verify SM SW on host and workstation 

CONCEPTS–xi, COPYSERV–xi, INTEL–xiii, 

SM84UNIX–xi 

install network hardware CONCEPTS–xi, 

COPYSERV–xi, INTEL–xiii, SM84UNIX–xi 

install storage expansion unit CONCEPTS–xi, 

COPYSERV–xi, INTEL–xiii, SM84UNIX–xi 
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CONCEPTS–xi, COPYSERV–xi, INTEL–xiii, 

SM84UNIX–xi 

installation INTEL–91 

installation and support OS guides CONCEPTS–xi, 

COPYSERV–xi, INTEL–xiii, SM84UNIX–xi 

installation guide, storage server CONCEPTS–xi, 

COPYSERV–xi, INTEL–xiii, SM84UNIX–xi 

installation planning CONCEPTS–xi, COPYSERV–xi, 

INTEL–xiii, SM84UNIX–xi 

installation process CONCEPTS–xi, COPYSERV–xi, 

INTEL–xiii, SM84UNIX–xi 

installation, Remote Mirror Option COPYSERV–95 

installation, Remote Mirror Option
hardware requirements COPYSERV–95 

installation, Remote Mirror Option (continued)
host operating systems COPYSERV–96 

pre-installation considerations COPYSERV–95 

site preparation COPYSERV–95 

software requirements COPYSERV–96 

installation

completing INTEL–99 

hardware COPYSERV–98 

preparation INTEL–27 

preparing a network INTEL–28 

Remote Mirror Option
Campus configuration COPYSERV–105 

hardware COPYSERV–98 

Highest Availability Campus configuration 

COPYSERV–98 

switch zoning overview COPYSERV–96 

software COPYSERV–114 

software
verifying COPYSERV–118 

switch zoning overview COPYSERV–96 

types
hardware environments INTEL–15 

new storage subsystem INTEL–15 

installing

AIX
client software SM84UNIX–19, SM84UNIX–20 

RDAC driver SM84UNIX–24, SM84UNIX–25 

client software
AIX SM84UNIX–19 

HP-UX SM84UNIX–48 

SMclient SM84UNIX–20, SM84UNIX–49, 

SM84UNIX–66 

SMruntime SM84UNIX–20, SM84UNIX–49, 

SM84UNIX–65 

Solaris SM84UNIX–65 

cluster server configuration INTEL–15 

cluster server software INTEL–74 

DNS/DHCP Management Console INTEL–42 

hardware in a cluster server environment INTEL–61 

host software
HP-UX SM84UNIX–50 

SMagent SM84UNIX–50, SM84UNIX–67 

SMutil SM84UNIX–51, SM84UNIX–68 

Solaris SM84UNIX–67 

HP-UX
client software SM84UNIX–48, SM84UNIX–49 

host software SM84UNIX–50 

SMutil SM84UNIX–51 

process diagram for SM84UNIX–10 

RDAC INTEL–55, INTEL–68, INTEL–69 

sequence of SM84UNIX–6 

SMagent INTEL–57, INTEL–71 

SMagent
in a standard configuration INTEL–70 

SMclient INTEL–66 

SMutil INTEL–59, INTEL–73 

software components
configuration types INTEL–13 

host computers INTEL–12 

management stations INTEL–12 
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installing (continued)
software

in a standard configuration INTEL–51, INTEL–54 

new installation process INTEL–51 

SMclient INTEL–52 

verifying SMclient installation INTEL–53 

verifying the Event Monitor installation INTEL–53 

Solaris
client software SM84UNIX–65, SM84UNIX–66 

host software SM84UNIX–67, SM84UNIX–68 

RDAC driver SM84UNIX–80 

storage management software INTEL–51, INTEL–65 

Storage Manager in a cluster environment INTEL–63 

VMware ESX Server configuration INTEL–97 

Windows software in a cluster server environment 

INTEL–61 

Intra-site configuration CONCEPTS–57 

Intra-site configuration
cabling examples COPYSERV–111 

overview COPYSERV–109 

setting up COPYSERV–111 

switch zoning COPYSERV–110 

IP addresses for FAStT controllers SM84UNIX–14 

IP addresses, assigning INTEL–32 

J
JNI

cards SM84UNIX–71, SM84UNIX–72 

installing driver SM84UNIX–72 

modifying HBA settings SM84UNIX–73, 

SM84UNIX–75 

settings SM84UNIX–109 

L
limitations

Linux operating system INTEL–129 

NetWare operating system INTEL–127 

Storage Manager 8.4 INTEL–4 

VMware ESX Server operating system INTEL–131 

Window operating system INTEL–121 

link interruptions COPYSERV–86 

Linux failover driver CONCEPTS–11 

Linux limitations INTEL–129 

Linux software Storage Manager INTEL–7 

Linux
configure the host COPYSERV–27 

failover protection CONCEPTS–43 

installation process INTEL–92 

reusing a FlashCopy logical drive COPYSERV–32 

software installation readme INTEL–91 

software packages
installing IBM FAStT Management Suite Java 

INTEL–95 

installing Storage Manager 8.4 client INTEL–93, 

INTEL–94 

installing the IBM Host Adapter device driver 

(qla2200.o or qla2300.o) INTEL–95 

load balancing, VMware ESX Server INTEL–131 

logical drive CONCEPTS–7 

logical drive failure COPYSERV–93 

logical drive group, capacity of CONCEPTS–40 

logical drive ownership COPYSERV–88 

logical drive types
primary CONCEPTS–50, COPYSERV–81 

secondary CONCEPTS–50, COPYSERV–81 

Logical Drive wizard
Allocate Capacity panel COPYSERV–13, 

COPYSERV–14 

Introduction panel COPYSERV–12 

Preview panel COPYSERV–19 

previewing COPYSERV–12 

Specify Array Parameters panel COPYSERV–15 

Specify FlashCopy Repository Logical Drive Capacity 

panel COPYSERV–18 

Specify Names panel COPYSERV–16 

logical drive-to-LUN mapping
default CONCEPTS–65 

defined CONCEPTS–64, CONCEPTS–68 

specific CONCEPTS–64 

logical drive-to-LUN terminology
default host group CONCEPTS–64 

host CONCEPTS–64 

host group CONCEPTS–64 

host port CONCEPTS–64 

mapping CONCEPTS–64, CONCEPTS–65 

storage partition CONCEPTS–63 

storage partition topology CONCEPTS–63 

storage partitions
mapping preference CONCEPTS–65 

logical drive
becomes full COPYSERV–36 

configure the host COPYSERV–24 

configure the host
AIX instructions COPYSERV–25 

HP-UX instructions COPYSERV–27 

Linux instructions COPYSERV–27 

Solaris instructions COPYSERV–29 

using the script editor and the command-line 

interface COPYSERV–25 

create using the FlashCopy Logical Drive wizard 

COPYSERV–20 

creating COPYSERV–19 

deleting COPYSERV–44 

disabling COPYSERV–39 

errors COPYSERV–86 

expected usage CONCEPTS–62 

link interruptions COPYSERV–86 

mapping a FlashCopy logical drive to the host 

COPYSERV–21 

modification operation COPYSERV–39 

modification priority setting CONCEPTS–91 

planning COPYSERV–8 

prepare the host operating system COPYSERV–20 

properties COPYSERV–37 

properties, changing COPYSERV–38 

re-creating COPYSERV–41 

resizing COPYSERV–42 

reusing COPYSERV–31 

reusing
AIX instructions COPYSERV–31 

HP-UX instructions COPYSERV–32 
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logical drive (continued)
reusing (continued)

Linux instructions COPYSERV–32 

Novell NetWare instructions COPYSERV–35 

Solaris instructions COPYSERV–34 

Windows instructions COPYSERV–35 

viewing status COPYSERV–36 

logical drives

adding or deleting INTEL–109 

base CONCEPTS–48 

connectivity and I/O CONCEPTS–55 

controller ownership within storage subsystems 

CONCEPTS–55 

creating INTEL–105, INTEL–109, INTEL–111, 

INTEL–117 

creating for mirror relationships COPYSERV–121 

creating from free or unconfigured capacity 

CONCEPTS–59 

creating step-by-step CONCEPTS–59 

data replication CONCEPTS–54 

deleting COPYSERV–125, INTEL–109, INTEL–111, 

INTEL–117 

Dynamic Logical Drive Expansion (DVE) 

CONCEPTS–39 

FlashCopy CONCEPTS–37, CONCEPTS–48 

FlashCopy repository CONCEPTS–38 

groups CONCEPTS–39 

mirror relationship CONCEPTS–54 

mirror repository CONCEPTS–38, CONCEPTS–53, 

COPYSERV–84 

overview CONCEPTS–37 

primary CONCEPTS–38 

recovering CONCEPTS–79 

repository CONCEPTS–48 

secondary CONCEPTS–38 

source CONCEPTS–38 

standard CONCEPTS–37 

supported INTEL–25 

target CONCEPTS–38 

VolumeCopy CONCEPTS–49 

Logical view CONCEPTS–73 

logical view, subsystem-management window 

CONCEPTS–22 

logical volume labels, VMware ESX Server INTEL–131 

logical volumes unrecognized, VMware ESX Server 

INTEL–131 

Logical/Physical View CONCEPTS–22 

loop settings SM84UNIX–73, SM84UNIX–75 

lsattr command SM84UNIX–37 

lsdev command SM84UNIX–35 

LUN attributes SM84UNIX–31 

LUN

address space CONCEPTS–64 

defined CONCEPTS–64 

LUNs

and access volumes SM84UNIX–8 

attributes SM84UNIX–29, SM84UNIX–31, 

SM84UNIX–32 

M
MAC address, Ethernet INTEL–30 

machine types and supported software CONCEPTS–1 

machine types, supported INTEL–4 

mail server configuration CONCEPTS–80 

make FC connections CONCEPTS–xi, COPYSERV–xi, 
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Notices 

IBM may not offer the products, services, or features discussed in this document in 

other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM 

product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may be 

used instead. However, it is the user’s responsibility to evaluate and verify the 

operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 

described in this document. The furnishing of this document does not give you any 

license to these patents. You can send license inquiries, in writing, to: 

   IBM Director of Licensing 

   IBM Corporation 

   North Castle Drive 

   Armonk, NY 10504-1785 

   U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS 

OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or 

implied warranties in certain transactions, therefore, this statement may not apply to 

you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. IBM may make improvements and/or 

changes in the product(s) and/or the program(s) described in this publication at any 

time without notice. 

Any references in this publication to non-IBM Web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those 

Web sites. The materials at those Web sites are not part of the materials for this 

IBM product, and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 

appropriate without incurring any obligation to you. 
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Trademarks  

The following terms are trademarks of International Business Machines Corporation 

in the United States, other countries, or both: 

 IBM Netfinity 

AIX TotalStorage 

  

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in 

the United States, other countries, or both. 

UNIX is a registered trademark of The Open Group in the United States and other 

countries. 

Other company, product, or service names may be the trademarks or service marks 

of others. 

How to send your comments 

Your feedback is important to help us provide the highest quality of information. If 

you have any comments about this document, please either fill out the Readers’ 

Comments form (RCF) at the back of this document and give it to an IBM 

representative, or submit them in one of the following ways: 

v   E-mail 

 Submit your comments over the Internet to: 

 starpubs@us.ibm.com

 Be sure to include the name and order number of the document and, if 

applicable, the specific location of the text that you are commenting on, such as 

a page number or table number. 

v   fax 

 Submit the completed Readers’ Comments form (RCF) at the back of this 

document by fax to: 

 1-800-426-6209

v   Mail 

 Fill out the Readers’ Comments form (RCF) at the back of this document and 

return it by mail. If the RCF Business Reply Mailer has been removed, you may 

address your comments to: 

 International Business Machines Corporation 

RCF Processing Department 

Dept. M86/Bldg. 050-3 

5600 Cottle Road 

San Jose, CA 95193-0001 

U.S.A.
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